
        Introduction to Data Editor

Data Editor is a key component of the Fujitsu COBOL Data File Tool Set.    It lets you create, update and 
browse data files, viewing them as they appear to your COBOL programs.    Data Editor is fast, intuitive 
and friendly, helping you make your updates with a minimal amount of effort. 

Because Data Editor lets you see the data using the same structure as your COBOL programs, it is easy 
for you to set values to test particular conditions in your programs.    Data Editor is therefore an important 
part of any testing process.



Main Features
Supports all COBOL Data File Formats
Data Editor supports the following COBOL Data file formats:

-    Sequential 

-    Line Sequential 

-    Index

-    Relative

Displays Elementary Data Items
Data Editor uses the COBOL record description to display the data separated into its elementary items.

Edit According to PICTURE Description or in Hexadecimal Format
Data can be edited in either the format most appropriate for the PICTURE description, or as a 
hexadecimal number.

Select Which Items to View/Edit
You can select which elementary items are displayed.    This is especially helpful for large records where it
is not possible to view all the data on the screen at one time.

Collapse/Expand Tables
You can expand COBOL tables (OCCURS items) to show all the items in the table or collapse tables to 
show only the first item.

Choose Between Redefining Record Descriptions
When records contain redefinitions or there are multiple record definitions you can dynamically choose 
which description should be used to display your data.

Switch Between Record and Table Views
Data Editor provides two ways of looking at the data:    Record View where one record is displayed at a 
time, and Table View where records are displayed in spreadsheet-like style with one record per row.

Work with Only a Range of Records
When you open a file you can select a range of records to work with, so you don’t have to load all the 
records from large files.

Save to Sequential File
All file formats can be written out to a sequential file.

Automatically Saves File Information
Data Editor saves all the information you enter about files so that you only need to enter this information 
once.

Link to Data Converter
Data Editor provides a link to Data Converter so you can convert your files to other formats after you have
applied your updates.



The Editing Process

The following steps give an overview of how to edit files using the Data Editor

(1)    Start Data Editor 

Click the Icon 
(2)    Setup the Environment

Setup the Data Editor environment.
(3)    Specify the Data File

Provide a new file name, select an existing data file or select from a list of recently opened files.
(4)    Select/Setup the Data File Details

Setup or update the: edit mode, select condition, file information, and library information 
corresponding to the data file specified in step (3). 
(5)    Edit/View the Data

Use the many Data Editor functions to view or edit the data.
(6)    Save or Discard Your Changes

You can exit with or without saving the changes made in your edit session.
(7)    Exit from Data Editor

Exit from Data Editor.





 Creating New Files - Overview

To create a new file follow these steps:

1.    From the File menu select New Data File.    This displays the Open dialog box. 

2.    Enter the name of the file to be created.    Clicking OK brings up the Data File Setup dialog box.

3.    Click on Analyze Library to specify and process the COBOL record description.    

4.    Enter any other required File Information and click OK.    Data Editor displays the Select Data File 
dialog box.

5.    As Add is automatically selected in the Select Data File dialog box you only need to click OK.

6.    Data Editor displays the record format screen ready for you to start entering data.

7.    To add more blank records select Add from the Record menu.

8.    Save your changes by selecting Save and Close Data File from the File menu.

Related Topics:

Specifying COBOL Data Descriptions
Entering Data File Information
Inserting a Comment



Specifying COBOL Data Descriptions

The Data File Setup dialog box requires that you provide a COBOL library containing the record 
description of the data you wish to create.    You specify a library using the following steps:

1.    Click the Analyze Library button.    Data Editor displays the Open file dialog box.

2.    Select the Library file and click OK.

3.    Respond OK to the “Analyze the Library <library-name>?” message.

4.    When the file is analyzed, Data Editor displays the file name and record length in the Data File Setup 
dialog box.    If there are any errors in the analysis, the Data Editor displays a message box explaining 
the error.



Entering Data File Information

You can specify the following information when creating a file:

File Organization
Select from Sequential, Line Sequential, Indexed and Relative.

The default is Sequential.

Record Format
Select from Fixed Length or Variable Length. 

The default value is Fixed Length. 

Variable length indexed files are not currently supported.

Record Length
You can specify a record length in the range 1 to 32760.

The default value is the record length from the analyzed library.

You cannot alter the record length for already existing indexed files.

Key Information
Key Information is enabled when you select indexed file organization.    You specify keys by clicking the 
Setup button and entering the key offsets and lengths in the dialog box.

Specifying Keys

Keys are specified using the following format:
Offset-1,length-1 [/offset-2,length-2] ...
Offsets and lengths are numbers of bytes.    Offsets start from 1.

Where keys have multiple parts use a “/” (slash) to separate the parts.

Example    “1,10/15,5”

Specifying Duplicate Keys

Check the Duplicate Key check box for any keys that can have duplicates.

Code Information
Select from ASCII or EBCDIC. 

The default is the Code Type defined in Environment Setup.



Inserting a Comment

After specifying the file details you can enter text in the comment field to describe the contents of the file.

The comment is optional.



Data File Setup

In the Data File Setup dialog you:

1.    Specify COBOL Data Descriptions

2.    Enter Data File Information

and, optionally,

3.    Add a Comment



Key Information Setup

The Key Information Setup dialog lets you enter or view the key details for indexed files.

Primary Key
Enter a string to define the structure of the primary key.    The format is:
offset, length [/offset-2, length-2]...
The first byte in the record is offset 1.

If the key is in multiple parts (a "split key") separate the parts using a "/".

Example: 1,10/16,5 

(the key is in two parts, the first is 10 bytes long starting at the first byte, the second part is 5 bytes long 
starting at the 16th byte)

The total length of the key definition string must be less than 256 characters.

Secondary Key
Enter a string to define the structure of the secondary key.    The format is:
offset, length [/offset-2, length-2]...
The first byte in the record is offset 1.

If the key is in multiple parts (a "split key") separate the parts using a "/".

Example: 1,10/16,5        (the key is in two parts, the first is 10 bytes long starting at the first byte, the 
second part is 5 bytes long starting at the 16th byte)

The total length of the key definition string must be less than 256 characters.

Duplicate Key
Check this box when duplicate keys are allowed.





Understanding the Select Data File Dialog Box

Whenever you open an existing file, the Data Editor displays the Select Data File dialog box.    You will 
also see the Select Data File dialog after you have specified details for a new file in the Data File Setup 
dialog.    This dialog box displays all the file details:

- folder name
- file name
- COBOL library information
- file information
- comment

so you can confirm you are loading the correct file.

It also lets you select the edit mode from: Update, View and Add.

And, for Update and View modes you can select the range of records to be loaded.    See Selecting a 
range of records.



Updating Existing Files

To update an existing file:

1.    From the File menu either select the file from the list of recently opened files, or select Open Data 
File.    Data Editor displays the Select Data File dialog box.

2.    Note that the File Edit Mode is set to Update.

3.    If you only want to update a particular range of records, select “Selection” from the Range drop down 
list and specify the range by clicking the Select Range button.

4.    Click OK to load the file or range of records.



Adding Records to Existing Files

To add records to an existing file:

1.    From the File menu either select the file from the list of recently opened files, or select Open Data 
File.    Data Editor displays the Select Data File dialog box.

2.    Change the File Edit Mode to Add.

3.    Click OK.    Data Editor displays a blank record ready to be filled in and added to the file.

4.    To add more records, from the Record menu select Insert, Append, Add or Copy.

The Record menu functions Insert and Append are only available for Sequential and Line Sequential files. 
The Record menu function Add is only available for Indexed and Relative files.    This is because you need
to determine the location for new records in Sequential and Line Sequential files, whereas Data Editor 
determines the record locations for Indexed and Relative files based on the key or relative record number 
values.



Browsing Existing Files

To browse records in an existing file:

1.    From the File menu either select the file from the list of recently opened files, or select Open Data 
File.    Data Editor displays the Select Data File dialog box.

2.    Change the File Edit Mode to View.

3.    If you only want to view a particular range of records, select “Selection” from the Range drop down list
and specify the range by clicking the Select Range button.

4.    Click OK to load the file or range of records.    Data Editor displays the records with all editing and 
updating functions disabled.



Selecting a Range of Records

If you select an Edit Mode of Update or View, you have the option of specifying a range of records to be 
loaded.    To do this select “Selection” from the Range drop down list and click the Select Range button to 
enter the record range.    This brings up the Record Range dialog box.

In the Record Range dialog box specify the numbers of the first and last record you wish to update or 
view.



Select Data File

The Select Data File dialog box displays information about the file you have selected for editing and gives
you the option of selecting the edit mode and range of records to be edited.

Data File Edit Mode
There are three edit modes: Update, View and  Add.

Select Range of Records
If you select an Edit Mode of Update or View, you have the option of specifying a range of records to be 
loaded.    To do this select “Selection” from the Range drop down list and click the Select Range button to 
enter the record range.    This brings up the Record Range dialog box.

In the Record Range dialog box specify the numbers of the first and last record you wish to update or 
view.



Record Range

The Record Range dialog box lets you specify the range of records to be loaded into the Data Editor.    
Specify the first and last records in the range.

First Record
Specify the number of the first record to be loaded.

Default is 1.

Last Record
Specify the number of the last record to be loaded.    If zero is entered the last record loaded will be the 
last record in the file.

Default is zero.



Selecting a Range of Records from Large Files

When working with large files you can focus your attention on a limited number of records by specifying a 
range of records to be loaded into Data Editor. This speeds the load of data and makes your task of 
navigating around the records easier.    To do this:

1.    In the Select Data File dialog box, Select Update or View as the Edit Mode.

2.    Select “Selection” from the Range drop down list and click the Select Range button to enter the 
record range.    This brings up the Record Range dialog box.

3.    In the Record Range dialog box specify the numbers of the first and last record you wish to update or 
view.    Click OK.

4.    Click OK in the Select Data File dialog box.    Data Editor loads the specified range of records.



Selecting Items in Large Files

Working with large files that have large records can be made more manageable by viewing only a few 
items within each record.

To select the data items that you view:

1.    In the View menu click on Select Items.    This brings up the Select Items dialog box.

2.    From the list of data names select the items you wish to display.    To select an item either click on the 
item, or put the focus on the item and press the space bar.    To deselect an item either click on it or put
the focus on it and press the space bar.    
Note:    Redefining items are indicated by the letter “R” to the left of the item.    Only the top level item 
in a redefining group is labeled with the letter “R”.
If you do not select any items all the non-redefining items will be displayed.

3.    If you want to view all the items in a table (an array defined using the OCCURS clause) select the 
Show OCCURS Items check box.

4.    If you want to view the data based on a different record definition select an alternative record from the
Record Format drop down list.    The list contains all 01 level record names that are in the COBOL 
library associated with the data file.

5.    Click OK.    Data Editor adjusts the record or table format view to show the selected items.

Note:    In table format view you can only select elementary items.    Selecting group items causes an error
message to be displayed.



Select Items Dialog Box

The Select Items dialog box lets you choose which record description, group and elementary items are 
displayed.    You can also select whether you want to view only the first occurrence in an OCCURS table 
or all the occurrences.

The Select Items dialog box contains the following:

Record Format
The Record Format drop down list contains all the 01 level records defined in the COBOL library 
associated with the data file.    Select the record definition you wish to use.    The items contained in the 
record are displayed in the list box below.

Show OCCURS items
If the selected record definition contains an OCCURS clause Data Editor enables this check box. 
Selecting the check box shows all occurrences in the list box.    Deselecting the check box shows only the 
first occurrence.

Select items to be displayed
Select the items to be displayed from the list of items.    The list contains all the items in the selected 
record with OCCURS items expanded or not according to the Show OCCURS Items check box.

Data Editor indicates redefining items by placing an “R” to the left of the item. Only the top level item in a 
redefining group is labeled with the letter “R”.

Some selections are restricted:

-    For indexed files the primary key cannot be deselected.

-    If you select a group item and an elementary item belonging to that group, only the group item is 
displayed.

-    If you select a redefined and a redefining item, only the redefined item is displayed.

-    In table format view you can only select elementary items.

Reset
The reset button deselects all selected items.    When no items are selected all the non-redefining items 
will be displayed.

OK
Click OK to return to the main Data Edit screen displaying your selected items.

Cancel
Click Cancel to return to the main Data Edit screen without making any changes to the display.



Hiding OCCURS Items

Data Editor gives you the option of switching on or off the display of the repetitions in a table.    The 
default is that only the first occurrence in the table is displayed.    For files with large records you may wish
to return to the default state.    To do this:

1.    From the View menu select Select Items.    This brings up the Select Items dialog box.

2.    Make sure the Show OCCURS Items check box is not checked.    This causes Data Editor to display 
only the first occurrence of the table items.

3.    Click OK.    Data Editor adjusts the record or table format view to hide all the occurrences after the 
first occurrence.



Navigating Around Files

You can navigate around large files by using the Locate, Record Number function.

1.    From the Locate menu select Record Number or select the Specify Record Number button  on the 
toolbar.    This brings up the Specify Record Number dialog box.

2.    Enter the number of the record you next wish to view.
3.    Click OK.    Data Editor displays the specified record.



Specify Record Number Dialog Box

Enter the number of the record you want to display.    When you click OK, Data Editor displays the 
specified record.    If you enter zero, Data Editor displays the last record in the file.





Editing Data Items

To edit a value in a data item click on the displayed value in the Data column.    Data Editor shows the 
selected item with a white background.    Change the value using the appropriate editing keys such as 
insert, delete, backspace and the character keys.

Points to be aware of:

-    Data Editor displays numeric values in decimal.    To see or edit the hexadecimal value use the View, 
Hexadecimal Edit function.

-    Data editing has insert and overtype modes, toggled by the Insert key.    The default mode is insert.    
As most numeric items have all their digits initialized to zero, you cannot enter any digits in insert 
mode unless you first delete some digits.    You may find overtype mode to be more convenient for 
editing numeric items.

-    The entry fields for alphanumeric items are proportional in length to the length of the PICTURE string.   
However, Data Editor does not limit the number of characters you can enter.    If you enter too many 
characters Data Editor displays a message on the status bar when you move off the field.

Related Topics
Editing Hexadecimal

Undoing Changes



Undoing Changes

Undoing Changes to the Current Record
Data Editor lets you undo changes, made in record format, to the current record.    To do this:

1.    From the Record menu select Undo, or select the Undo button  on the toolbar.
Data Editor disables the Undo function when no data items have been updated or when you move off the 
record you have just edited.

2.    Data Editor restores all the data items in the record to their values when you last arrived at the record.
For example, if you make some edits to record 1, go to record 2, come back to record 1, make some 
more edits, then select Undo, the values will be restored to the first set of edits you made.
Undoing Changes to All Records
If you want to revert to the data values before you started editing the file, select Close Data File from the 
File menu and respond “No” to the question “Data has been updated.    Do you want to save the 
changes?”.

Undoing Record Deletions
Until you save your changes you can recover deleted records by using the Record menu Restore 
function:

1.    Display the deleted record in record format.

2.    From the Record menu select Restore.

3.    Data Editor removes the delete status from the record.



Editing Hexadecimal

To view or edit the hexadecimal value of any field:

1.    Select the field.    Data Editor displays the field with a white background.

2.    From the View menu select Hexadecimal Edit 
or
Select the Hexadecimal Edit button  on the toolbar
or
Use the right mouse button to bring up the pop-up menu and select Hexadecimal Edit.
Note:    When using the pop-up menu:
a)    The pointer has to be off the data entry field.
b)    Clicking the right mouse button does not select the field under the pointer.    To select a field you 
must use the left mouse button or the cursor movement keys.

3.    Data Editor displays the Hexadecimal Edit dialog box.

4.    Make your edits to the hexadecimal value.    Pressing enter or clicking on the dialog box’s close button
 confirms your changes and returns you to the main editing window.



Selecting Items

To select the data items that you view:

1.    In the View menu click on Select Items.    This brings up the Select Items dialog box.

2.    From the list of data names select the items you wish to display.    To select an item either click on the 
item, or put the focus on the item and press the space bar.    To deselect an item either click on it or put
the focus on it and press the space bar.    
Note:    Redefining items are indicated by the letter “R” to the left of the item.    Only the top level item 
in a redefining group is labeled with the letter “R”.
If you do not select any items all the non-redefining items will be displayed.

3.    If you want to view all the items in a table (an array defined using the OCCURS clause) select the 
Show OCCURS Items check box.

4.    If you want to view the data based on a different record definition select an alternative record from the
Record Format drop down list.    The list contains all 01 level record names that are in the COBOL 
library associated with the data file.

5.    Click OK.    Data Editor adjusts the record or table format view to show the selected items.

Note:    In table format view you can only select elementary items.    Selecting group items causes an error
message to be displayed.



Displaying OCCURS Items

To show all the items in a table (an array defined using the OCCURS clause):

1.    From the View menu select Select Items.    This brings up the Select Items dialog box.

2.    Select the Show OCCURS Items check box.    This displays all the occurrences in the item list box.

3.    If you wish to view only some items, select these items in the item list box.    To select an item either 
click on the item, or put the focus on the item and press the space bar.    To deselect an item either 
click on it or put the focus on it and press the space bar.    
Note:    Redefining items are indicated by the letter “R” to the left of the item.    Only the top level item 
in a redefining group is labeled with the letter “R”.
If you do not select any items all the non-redefining items will be displayed.

4.    Click OK.    Data Editor adjusts the record or table format view to show the selected items.

Note:    In table format view you can only select elementary items.    Selecting group items causes an error
message to be displayed.



Inserting, Appending, Adding and Copying Records

To add more records to a file use the Insert, Append, Add or Copy on the Record menu.

The Record menu functions Insert and Append are only available for Sequential and Line Sequential files. 
The Record menu function Add is only available for Indexed and Relative files. This is because you need 
to determine the location for new records in Sequential and Line Sequential files, whereas Data Editor 
determines the record locations for Indexed and Relative files based on the key or relative record number 
values.



Deleting Records

To delete a record:

1.    Display the record in record format.

2.    From the Record menu select Delete
or
Click on the delete button  on the toolbar.

3.    Data Editor marks the record for deletion.    The data of records marked as deleted is displayed in 
gray and the Status shows “Delete”.    The record is not deleted until you save your changes.    You can 
use the Record menu Restore function to remove the Delete status.



Altering Record Lengths for Variable Length Files

You can alter the record length of records added by the Insert, Add, Append and Copy functions.    To do 
this:

1.    Locate the Record Length entry field below the toolbar.    Confirm that it is enabled.    If it is disabled 
you cannot alter the record length for this record.

2.    If the field is enabled click on it.

3.    Change the length and press Enter.

Valid values for the record length are in the range 1 to the maximum record length.    The maximum record
length is specified in the Record Length field in the Data File Setup dialog box.



Saving Changes

Changes made to your data in the Data Editor are not made permanent until you execute the Save and 
Close Data File function on the File menu.    Therefore follow these steps to save your changes:

1.    From the File menu select Save and Close Data File or click on the Save and Close button  on the 
toolbar.

2.    Data Editor displays the Confirm Updates dialog box.    This shows the numbers of records updated, 
added or deleted so you can check that no unintentional updates are being saved.
3.    Click OK to save the updates and return to the initial Data Editor screen.



Discarding Changes

Changes made to your data in the Data Editor are not made permanent until you execute the Save and 
Close Data File function on the File menu.    You can therefore discard your updates by using the Close 
Data File function.    Follow these steps to discard your changes:

1.    From the File menu select Close Data File or click on the Close Data File button  on the toolbar.

2.    If you made changes to the file, Data Editor displays a “Data has been updated.    Do you want to 
save the changes? “ message.
3.    Click on the NO button.    Your changes are discarded, the file is closed and you are returned to the 
initial Data Editor screen.





Linking to Data Converter

Data Converter converts files from one format to another.    Formats that it converts between are: the 
COBOL file organizations, CSV format (comma-separated values), changed item descriptions, and 
different character codesets.    Data Editor provides the ability to link to Data Converter so you can take 
your edited data and convert it to another format.    Another useful feature is that Data Editor can pass just
the data items that are selected in the Select Items function.    If no items are selected all the elementary 
items are output

Notes
1.    For tables, defined using the OCCURS clause, all the data fields are passed to Data Converter.    
They are not affected by the Select Items settings.
2.    Records with delete status are output and converted in this function.

How to Link to Data Converter

1.    From the Option menu select Link to Data Converter or use the Link to Data Converter button  on 
the toolbar.

2.    Data Converter displays the Link to Data Converter dialog box. Setup the following items:
- Output Data Format
The output format can be either CSV Format, or Data File Format (i.e. any supported format other than 
CSV).
- Output items selected in Select Items only
When this check box is checked, only selected data fields are output.
The default record length of the output file is determined by the following:

- When the check box to output only the selected items is checked:    the record length is the sum of the 
lengths of the selected data items. 

- When the check box to output only the selected items is not checked:    the record length is the sum of 
the lengths from the first selected item to the last selected item plus the lengths of unselected items. 

3.    Click the Start Data Converter button.

4.    Data Converter starts and displays the fourth window of the Conversion Wizard (Data Editor passes 
the information normally specified in the other Wizard windows).

See the on-line help for Data Converter for full details on how to use it.





Changing Fonts

Data Editor gives you the ability to configure the font used in the data display windows.

From the View menu select Font.    Data Editor displays the system’s standard font selection dialog.



Customizing the Data Editor Screen

You can select which elements are displayed in the main window.    Data Editor gives you the ability to 
switch on or off the display of the following elements:

- level numbers

- data descriptions

- offsets

- the toolbar

- the status bar

From the View menu select Screen Format.    In the cascaded menu click on an item to switch its display 
off or on.

By default the display of all these elements is switched on.

You can also configure your view by selecting the items that Data Editor displays.    This lets you focus 
your attention on a few items.



Choosing the Data Editor Display Format

Data Editor provides two formats for viewing and updating records - Table Format and Record Format.    
Table Format displays each record as a row in a table, like a spreadsheet.    Record Format displays one 
record at a time with the data items listed vertically, one item per row.    Some functions are only available 
in one of the formats.    The details of each format and available functions are provided in the following 
topics:

Record Format - Display Details

Record Format - Supported Functions

Table Format - Display Details

Table Format - Supported Functions



Record Format - Display Details

The record format display has the following elements

Status line (below the toolbar)

The status line contains: Status, Record Length, and Record Number.

Level No

Displays the level numbers of the data items as defined in the COBOL library file.

Item Name

Displays the names of the data items as defined in the COBOL library file.

Attribute

Displays the data descriptions of the data items as defined in the COBOL library file.    See Formats for 
Data Descriptions

Offset

Displays the offsets of the items from the beginning of the record.

Data

Displays the data contents of each item.



Table Format - Display Details

The table format display has the following elements

Item Name (below Toolbar)

Contains the name of the item for the currently selected cell.

Data Edit Area (below Toolbar)

Displays the contents of the currently selected cell.    Click on this item to edit the data.

Item

Displays the names of the data items as defined in the COBOL library file.

Attribute

Displays the data descriptions of the data items as defined in the COBOL library file.    See Formats for 
Data Descriptions

Offset

Displays the offsets of the items from the beginning of the record.

Status

Displays the status of the records.

Data (data contents)

Displays the data contents of each item.    Select the cell containing the data you wish to edit then click on
the data edit area to edit the value.



Configuring the Environment

Data Editor lets you configure a number of behavioral details.

The configurable areas are:

- Folders

- Work Environment Details

- Backups

- COBOL Analysis Options

- Code Conversion Details

- Display Formats

To configure your environment:

1.    Close any opened files.

2.    From the Options menu select Environment Setup.    This brings up the Environment Setup dialog 
box.

3.    Select the tab containing the details you wish to configure.    See the above topics for details of the 
tabs.

4.    Click OK, when setup is complete.



Folder Details

You can specify which folders Data Editor should use for its information and work files.

Data Editor Information Files
Data Editor stores all the information you provide about the data files in information files.    These files 
take the data file name with a .LNC extension.    You can specify the folder to be used to store these files.  
The root folder cannot be specified. 

The default folder is the TEMP folder within the Data Tools installation folder.

Use the Browse function to select an existing folder.

Data Editor Work Files
Data Editor creates temporary work files when you are editing files.    You can specify the folder to be 
used to store these files.    The root folder cannot be specified.

The default folder is the TEMP folder within the Data Tools installation folder.

Use the Browse function to select an existing folder.



Work Environment Details

You can configure the following behaviors:

COBOL Embedded Characters
Empty space in character data items can be filled with BLANKs or NULL values. If BLANK is specified, 
single byte spaces are embedded for X type items and double byte spaces for N type items. 

The default setting is BLANK.

Default Edit Mode Setup
When a previously edited file is loaded you can specify the default edit mode for the Select Data File 
dialog box.    The options are Update, View and Add.

The default setting is Update.

Warning Message for Add/Copy for Indexed/Relative Files
When you add or copy records you lose the ability to undo any changes made to the current record 
before the add/copy operation.    You can have Data Editor display a message reminding you of this fact 
every time you do an add or copy in indexed or relative files.    Check the Display Message box if you 
want to see the message.    

If an error occurs and the message box display is suppressed the changes cannot be undone.

The default setting is to suppress the display.



Backup Details

You can select whether or not Data Editor makes backups of all files you edit.

Check the check box, to have Data Editor make backups. The backup files are created in the work file 
folder specified on the Folders tab.    The backup file name is [Filename]+[BAK]

Example    Datafile name Backup file name

          DATA01.DAT    --    DATA01.DAT.BAK



COBOL Analysis Option Details

You can specify the following for Data Editor’s COBOL analysis process:

Tab code
Select whether tabs are expanded to every 4th column or every 8th column. 

Default setting is to expand to every 8th column.

Character code 
The value for the COBOL library character code is ASCII, and no options are applicable. 

Case Sensitive
Select case sensitivity when processing the source library. 

Default value is not to be case sensitive.

Reference Format Type
Source program

This setting is not necessary in Data Editor.

Library

Specifies whether the COBOL library files are fixed length format, variable length format or free format. 

The default setting is Variable Length Format.



Code Conversion Details

Specifies the character set used in the data file.    Supported code types are ASCII and EBCDIC.

The default setting is ASCII.



Display Format Details

Table Format : Limit Item Display Width
Max Display Width

Set the maximum width for displaying items in the Table Format screen.    When 0 is specified the display 
width is determined by the size of each item. 

The default value is 0.

Edit Procedure
Suppress Display of Leading Zeros

Specify whether zeros should be suppressed when displaying numeric items.

Default setting is not to zero suppress.





File Menu
{button File,JI(`',`MENU_FILE')}{button Record,JI(`',`MENU_RECORD')}{button

Locate,JI( `',`MENU_INSPECT')}{button View,JI(`',`MENU_DISP')}{button Options,JI(`',`MENU_OPTION')}
{button Help,JI(`',`MENU_HELP')}

New Data File
Displays the Open and Data File Setup dialogs to help you create a new data file.

Open Data File
Displays the Open and Select Data File dialogs so that you can select a file to edit and confirm the file 
details and edit mode.

Save as Sequential File
Displays the Save As dialog so that you can specify a file name.    On clicking the Save button in the 
dialog the data is saved to a sequential file 

Save and Close Data File
Displays a dialog box confirming the number of updates, additions and deletions made to the file.    
Responding OK to this dialog saves your changes, closes the file and returns you to the Data Editor initial
screen.

If no updates have been made the function closes the file and returns you to the Data Editor initial screen.

Close Data File
If no updates have been made the function closes the file and returns you to the Data Editor initial screen.

If updates have been made, displays a message box asking you to confirm that you do not want to save 
the updates.

File List
Lists the names of the last five data files opened in Data Editor.

Selecting one of the names displays the Select Data File dialog for you to confirm the edit mode and file 
details.

Exit
Exits Data Editor.

If updates have been made, displays a message box asking you to confirm that you do not want to save 
the updates.



Record Menu
{button File,JI(`',`MENU_FILE')}{button Record,JI(`',`MENU_RECORD')}{button

Locate,JI( `',`MENU_INSPECT')}{button View,JI(`',`MENU_DISP')}{button Options,JI(`',`MENU_OPTION')}
{button Help,JI(`',`MENU_HELP')}

Undo
Undoes updates to the current record.    Undo can only be used while the edited record is displayed.    
Once you move to another record you can no longer undo the updates.

Insert
Displays a dialog allowing you to specify the number of records to be inserted before the currently 
displayed record.

Insert is only available for sequential and line sequential files, in Record Format view.

Append
Displays a dialog allowing you to specify the number of records to be added at the end of the file.

Append is only available for sequential and line sequential files, in Record Format view.

Add
Adds one record.    After the key or relative record number is input, the record is placed in its appropriate 
position in the file.

Add is only available for indexed and relative files, in Record Format view.

Copy
For Sequential and Line Sequential Files

Displays a dialog allowing you to specify the number of copies to be made of the current record and the 
location in the file to insert those copies.    If you enter zero as the copy location the copies are added at 
the end of the file.

For Indexed and Relative Files

Makes one copy of the current record. After the key or relative record number is input, the record is 
placed in its appropriate position in the file.

Delete
Marks the current record for deletion. (Or, for sequential and line sequential files displays a dialog box 
allowing you to enter the number of records that are to be deleted starting from the current record.)    
Records marked for deletion can be retrieved using the Restore function.    The records are actually 
deleted when you save your changes.

Restore
Restores the current record marked for deletion.



View Menu
{button File,JI(`',`MENU_FILE')}{button Record,JI(`',`MENU_RECORD')}{button

Locate,JI( `',`MENU_INSPECT')}{button View,JI(`',`MENU_DISP')}{button Options,JI(`',`MENU_OPTION')}
{button Help,JI(`',`MENU_HELP')}

Table format
Switches the view of the data from Record format to Table format.    When there are more records than 
can be displayed on the screen, Data Editor displays the current record at the top of the window.

Record format
Switches the view of the data from Table format to Record format.    Data Editor displays the record that 
had focus in the Table format view.

Font
Displays the font configuration dialog box.    Data Editor uses the selected font for the data and item 
information in the main window.

Screen Format
Displays a sub-menu of screen elements that you can switch off or on.    Click on the element to turn its 
display on or off.    A check mark by the element indicates that it is being displayed.    The switchable 
elements are:

- Level Number

- Description

- Offset

- Toolbar

- Status Bar

Select Items
Displays a dialog for you to select which data items are displayed.    The dialog offers the following display
selections:

-    Which record format to use

-    Whether OCCURS items are expanded or collapsed

-    Which items to display

-    Which descriptions to use when there are REDEFINE alternatives.

Hexadecimal Edit
Displays a dialog for viewing and editing the current item in hexadecimal.



Locate Menu
{button File,JI(`',`MENU_FILE')}{button Record,JI(`',`MENU_RECORD')}{button

Locate,JI( `',`MENU_INSPECT')}{button View,JI(`',`MENU_DISP')}{button Options,JI(`',`MENU_OPTION')}
{button Help,JI(`',`MENU_HELP')}

The Locate menu functions are used for navigating around the file in Record Format view.

Previous Record
Displays the record previous to the current record.

Next Record
Displays the record after the current record.

Record number
Displays a dialog for you to enter the number of the record to be displayed.

First Record
Displays the first record in the file or loaded record range.

Last Record
Displays the last record in the file or loaded record range.



Options Menu
{button File,JI(`',`MENU_FILE')}{button Record,JI(`',`MENU_RECORD')}{button

Locate,JI( `',`MENU_INSPECT')}{button View,JI(`',`MENU_DISP')}{button Options,JI(`',`MENU_OPTION')}
{button Help,JI(`',`MENU_HELP')}

Environment Setup
Displays the Environment Setup dialog that lets you configure the Data Editor environment.    The items 
you can configure are:

- Default folders for saving the data files and for storing work files.

- Work environment options such as the characters inserted for null data, the default edit mode and the 
display of a message on Add and Copy functions.

- Whether to create backups

- Options for Data Editor COBOL source analysis

- Code conversion options

- Display options for the maximum width of table items and whether to suppress leading zeros.

Link To Data Converter
Passes the currently loaded data file to Data Converter for conversion into other file formats.    Data Editor
passes information about the file to Data Converter so you enter Data Converter at the Conversion 
Wizard window 4.



Help Menu
{button File,JI(`',`MENU_FILE')}{button Record,JI(`',`MENU_RECORD')}{button

Locate,JI( `',`MENU_INSPECT')}{button View,JI(`',`MENU_DISP')}{button Options,JI(`',`MENU_OPTION')}
{button Help,JI(`',`MENU_HELP')}

Help Topics
Displays the Help contents list.

About Data Editor
Displays version number and copyright information.



Keyboard Shortcuts

Data Editor provides the following keyboard shortcuts:

Ctrl + O Open a data file.

Ctrl + S Save and close the data file.

Ctrl + Z: Undo the changes made to a record.

Ctrl + AAppend record(s).

Ctrl + H Hexadecimal edit.

F7 Display the previous record.

F8 Display the next record.

F5 Display the first record.

F6 Display the last record.



Toolbar

The toolbar buttons perform the following functions:

          Create a new data file.
          Open an existing data file
          Environment setup
          Link to Data Converter
          Save to a sequential file
          Save and close the data file
          Close the data file

          Switch to record format view
          Switch to table format view
          Select items to display
          Hexadecimal edit

          Append record(s)
          Copy record(s)
          Delete record(s)
          Undo changes to current record

          Display the specified record
          Display the first record in the file
          Display the record before the current record
          Display the record after the current record
          Display the last record in the file

          Display help on an item you click on
          Display the Help Topics window



Status Bar

The Status Bar displays information about the file being edited and provides messages explaining 
functions and buttons under the pointer.

The Status Bar presents the following information:

Item Possible Values Explanation
ORGN SEQ / LINE / INDX / REL Displays the organization of the file being 

edited: SEQuential/ LINE Sequential/ INDeX
/ RELative

ATTR FIX / VAR Displays whether the records are FIXed or 
VARiable length.

MODE UPDT / VIEW /ADD Displays the edit mode: UPDaTe / VIEW/ 
ADD

Message A message Used for displaying messages.    Whenever 
the pointer is over a toolbar button or menu 
function the message gives an explanation 
of the function.

Display Formats for Data Descriptions

Data Editor uses the following formats when displaying data descriptions.

COBOL PICTURE Screen Display Format

A X(1)A

X X(1)

XA99AX X(6)

N N(1)

NBN #N(3)

99/99 #X(5)9

\\\,\\9 #X(7)

9 9(1)

S9 S9(1)

9V9 9(1)V9(1)

999999999999999999 9(18)

1(8) BIT 1(8) B

1(8) DISPLAY 1(8) D



9(4) PACKED-DECIMAL 9(4) PD

9(4) BINARY 9(4) B

9(4) COMP 9(4) C

COMP-1 9(4) C1

COMP-2 9(8) C2

9(4) COMP-n(n:3 - 5) 9(4) Cn(n:3 - 5)

POINTER 9(9) P

INDEX X(4) I



Record Format View

Depending on the processing mode Record Format View lets you add, delete, update and edit data.

Functions Available
Record Format - Supported Functions

Screen Elements
Record Format - Display Details



Record Format - Supported Functions

The Record Format screen supports the following functions in add and update mode:

- Editing Data Items

- Editing Hexadecimal

- Undoing Changes

- Inserting, Appending Adding and Copying Records

- Deleting Records

- Altering Record Lengths for Variable Length Files

- Saving Changes

- Discarding Changes

- Other functions

In View Mode the Record Format screen supports the following functions:

- Navigating Around Files

- Close

- Other functions



Table Format View

The only updates supported in table format view are the data item update functions.

Functions Available
Table Format - Supported Functions

Screen Elements
Table Format - Display Details



Table Format - Supported Functions

The Table Format screen supports the following functions in add and update mode:

- Editing Data Items

- Editing Hexadecimal

- Saving Changes

- Discarding Changes

- Other functions

In View mode the Table Format screen supports:

- Close

- Other functions



Confirm Update Dialog

When you save a file Data Editor displays the Confirm Update dialog box, displaying the details of the 
changes you have made.    The information presented is:

- Update
The number of records updated.

- Add
The number of records added.

- Delete
The number of records deleted

- Save Select Items
When checked Data Editor saves, in its information file, the items you selected to display.



Other Functions (Record Format View)

In the record format view you can also:

Save to a sequential file

Switch to the Table Format view

Select Font

Select items

Link to Data Converter



 Close File

To close a file:

1.    From the File menu select Close File or click on the Close File button, , on the toolbar.

2.    Data Editor closes the file and clears the screen.



Other Functions (Table Format View)

In the table format view you can also:

Save to a sequential file

Switch to Record Format view

Select Font

Select Items

Link to Data Converter



Copy Current Record

Data Editor displays this dialog for sequential and line sequential files.    You specify:

Insert at Record Number
Data Editor copies the current record and inserts the copies before the record number specified in this 
entry field.    If you specify zero Data Editor appends the copies to the end of the file.

Number of Copies
Enter the number of copies to be made.



Number setup

Data Editor displays this dialog when you insert, append or delete records in sequential or line sequential 
files.    In it you specify:

Number
For inserting or appending records, specifies the number of records to be created.

For delete, specifies the number of records to delete from (including) the displayed record forward.





General Limitations and Precautions

Data Editor has the following general limitations and precautions:

1.    Data Editor must not be terminated forcefully.    You may lose the file being edited.

2.    When a system error or internal error occurs when editing a file, the process cannot be restored and 
the contents of the file are lost.    To protect against this loss take a backup beforehand.    If an 
indexed file is destroyed, and no backup is available, try running the File Restore utility in the 
COBOL85 File Utility.

3.    If the organization and attributes entered for the file do not match those of the actual file, the file is 
not opened.

4.    Results may be incorrect if the file being edited is being used by another application.

5.    Limitations for indexed files:

- Duplicate keys

You cannot load a range of records for indexed files that allow duplicate primary keys.

- Sub-key

When creating new files, no more than 4 sub-keys can be defined.

- Number of key items

The number of key items depends on the number of entries that can be made in the edit field in the 
key information dialog box.    The maximum number of characters in the field is 255 bytes.

- Variable length records

Indexed files with variable length record format are not supported.

- Order of records

Numeric keys are ordered by absolute key value.

6.    In the table format screen, confirm any changes to the data by either moving the focus or pressing 
the Enter key.    Using any other function causes the changes to be lost.

7.    Data Editor creates the following files in the work file folder.    You need to ensure there is sufficient 
space available to hold these files.

- Work file for file operations:

The work file is usually about twice the size of the file being edited.    If a large number of records are 
added the work file will require additional space equal to twice the total size of the added records.

- Error file:

The error file contains the results of the COBOL library analysis.

8.    The maximum length of data items that Hexadecimal edit can handle is 16,384 bytes.

9.    You cannot edit BIT attribute items using Hexadecimal edit.

10.    Files with variable length records cannot be passed to Data Converter.

11.    The link to Data Converter cannot handle more than 500 data items.

12.    Contents of BIT attribute data items, within an OCCURS group, cannot be assured.

13.    The root directory cannot be used for:
- work files
- data file information files



- saving the data as a sequential file.

14.    The folder for creating work files and saving data file information files requires a system that 
supports long file names.

15.    The maximum number of records that Data Editor can handle is 100,000. 

16.    Data fields that have code conversion errors are filled with "_" (under scores). 

17.    When the record length derived from the COBOL library analysis is different from the actual record 
length of the data file, Data Editor behaves as follows:

(i)    Record length from data description > record length of data file 

- Data Editor lets you enter data beyond the end of the data file records, but when the records are 
written to the file they are truncated at the length supported by the file.

(ii)    Record length from data description < record length of data file 

- You cannot enter or edit the data that is beyond that covered by the data description.

- When adding or copying records Data Editor fills the area of the records beyond that covered by the 
data description with NULLs.

(iii)    Key length from data description < key length in the indexed file

- Data Editor disables adding and copying records.

18.    For files with the same name but stored in different directories, Data Editor uses the same data 
information file.    Consequently you can only edit both files if they have the same record format.

19.    Data Editor cannot access data files in the root directory of a drive.    Put the data files in sub 
directories.

20.    Back up files are only supported in systems that support long file names.



Limitations for Display and Operations

1.    You cannot select a font size greater than 28.

2.    Undo is only supported when you are editing the current record.    If you display any other record or 
change the display format it is no longer possible to undo your changes.



Limitations for Copy Libraries

COBOL COPY library analysis has the following limitations:

1.    Libraries must contain COBOL data definitions.

2.    The maximum number of item definitions is 9998.    Table indices (specified in the OCCURS clause) 
are included in this count.

3.    When the library contains several records (01 level), all the records should be the same length.

4.    When a library contains nested COPY statements, the other library files must be in the same 
directory as the main library..

5.    Data Editor does not support the following clauses:

-    OCCURS DEPENDING ON 

-    REDEFINES at the 01 level

6.    Data Editor ignores the following specifications:

-    Level 77 data items

-    Level 66 or 88 data items

-    BASED ON clause

-    JUSTIFIED clause

-    BLANK WHEN ZERO clause

-    RENAME clause

-    KEY IS clause

-    VALUE clause

-    VALUE NULL clause

-    Symbol and symbolic constants for condition names

-    PRINTING POSITION clause

-    CHARACTER TYPE clause

-    SYNC clause

7.    Data Editor makes the following interpretations or assumptions:

-    Items with USAGE INDEX are handled as PIC X(4).

-    External floating point data items are handled as alphanumeric items.

-    Pointer data items are handled as "PIC    9(9) COMP". However, "9(9)P" is displayed in the 
attribute column .

-    COMPUTIONAL-1 and COMPUTIONAL-2 items are handled as "PIC X(4)", and "PIC    X(8)" 
respectively.    However, embedded characters are set to NULL regardless of the COBOL Embedded 
Characters setting in the environment setup (work environment)

-    COMPUTIONAL-4 and COMPUTIONAL-5 items are treated as binary items.    However, in the 
internal description of the memory area for COMPUTIONAL-5 items, the lower address byte 
positions contain the low order digits and higher address byte positions contain the high order digits.

-    Currency signs are not reflected.

-    Numeric edited items and alphanumeric edited items are handled as alphanumeric items.



8.    If the library does not contain an 01 level item, Data Editor generates the record: 
TF-DATAEDITOR-ADDREC.

9.    Pseudo text (parentheses etc.) is not supported.

10.    When a USAGE clause is attached to a group item, all the elementary items are displayed as 
follows:

Binary items :BN

Internal decimal items :PD



Limitations for Data Files

1.    For files with fixed length records, the record length specified in the Data File Setup dialog should be 
same as the actual record length in the file. Otherwise the following errors may occur:

-    The last record cannot be updated.

-    Records cannot be added, deleted or copied.

-    The correct data items are not displayed.

2.    If an error occurs when updating an indexed file, and the indexed file is lost, run the File Restore 
process of the COBOL85 File Utility.

3.    The maximum supported record length is 32,760 bytes.

4.    Line sequential files with COMP, PACKED-DECIMAL,    and BIT items cannot be processed normally.

5.    Errors may occur if the record format is changed during indexed file creation or update, and the 
relative position or length of key data items does not match.    Errors may also occur if the key item 
displayed is changed (in the Select Items function).

6.    Errors may occur if the data file being edited, is being used by another application.

7.    Data Editor cannot handle files with full path names greater than 259 characters.



Trademarks

Microsoft Windows, and Windows NT are registered trademarks of Microsoft Corporation USA in USA and
other countries.



About Menu Commands



New Data File
Displays dialog boxes to help you define a new data file



Open Data File
Opens an existing data file.    You can also specify a new file in the Open dialog.



Save as Sequential File
Saves the records of the file being edited to a sequential file.



Save and Close Data File
Displays a dialog confirming the updates made to the file, then saves the updates.    Clears the window 
after saving the file.



Close Data File
Closes the file and clears the window.    If data has been updated, Data Editor displays a message box 
seeking confirmation that the updates should be discarded.



Latest file 1
Opens the listed data file.



Latest file 2
Opens the listed data file.



Latest file 3
Opens the listed data file.



Latest file 4
Opens the listed data file.



Latest file 5
Opens the listed data file.



Exit
Closes the Data Editor.    If data has been updated, Data Editor displays a message box asking you 
whether the updates should be discarded or saved.



Undo
Undoes changes made to the current record.    Once you move to another record it is no longer possible 
to undo the changes.



Insert Record (Sequential and Line Sequential Files)
Inserts a record before the displayed record.    You can insert multiple records.



Append Record (Sequential and Line Sequential Files)
Adds record(s) to the end of the file.



Add Record (Indexed and Relative Files)
Adds one record.    Records are arranged in ascending order of the primary key or relative record number 
for indexed and relative files respectively



Copy Record
Sequential and Line Sequential files - copies the currently displayed record and inserts it at the location
you specify.    If you specify zero as the target location, the record is copied to the end of the file.    You can
make multiple copies.

Indexed and Relative files - the currently displayed record is copied.    Once copied you can update the 
key or relative record number.    Data Editor then inserts the record at the appropriate position in the file.



Delete Record
Indexed and Relative files - Deletes the current record. 

Sequential and Line Sequential files - Displays a dialog box in which you specify the number of records
to be deleted.

Deleted records can be restored by the Restore command. 



Restore Record
Restores the current record marked for deletion.    Only one record can be restored at a time.



Table Format View
Switches from Record Format view to Table Format view.    If there are more records than can be 
displayed in the window the current record is displayed at the top.



Record Format View
Switches from Table Format view to Record Format view.    The record with focus is displayed.



Specify Font
Displays a dialog for you to select a different font for the record information and data.    Default font is 
Courier New.



Change Screen Format
Displays a sub-menu from which you select the screen elements to display



Level Number
If checked Data Editor displays the item level numbers.    (Record Format view only)



Description
If checked Data Editor displays the item descriptions.



Offset
If checked Data Editor displays the offsets of the items within the record.



Toolbar
If checked Data Editor displays the toolbar.



Status Bar
If checked Data Editor displays the status bar at the base of the window.



Select Items
Displays a dialog in which you select the items to be displayed.    Selections presented:

- Specify the record format.

- Show OCCURS items.

- Select the items to be displayed.

- Choose REDEFINES items.



Hexadecimal Edit
Displays and edits the current data item in Hexadecimal.



Previous Record
Displays the record before the current record.



Next Record
Displays the record after the current record.



Record Number
Displays a dialog for you to specify the record number to be displayed.



First Record
Displays the first record loaded by Data Editor.



Last Record
Displays the last record loaded by Data Editor.



Environment Setup
Lets you configure the Data Editor environment.    You can setup the following items.

- Default folders

- Work environment

- Backup options

- COBOL analysis options

- Code conversion options

- Display format



Link to Data Converter
Passes the data being edited to Data Converter for conversion to different code sets, file organizations or 
CSV Format.



Help Topics
Displays the help topics.



About Data Editor
Displays the version number and copyright information for Data Editor.



About Environment Setup Controls



Folder for Data Editor Information Files
Folder to be used for the Data Editor information files.    The root folder cannot be specified. Default value 
is the TEMP folder within the Data Editor installation folder.



Browse for Information Folder
Select the information file folder by browsing the current folder structure.



Folder for Data Editor Workfiles
Folder to be used for the Data Editor work files.    The root folder cannot be specified. Default value is the 
TEMP folder within the Data Editor installation folder.



Browse for Workfile Folder
Select the workfile folder by browsing the current folder structure.



COBOL Embedded Characters
Selection can be made between Blank Space and NULL if there are spaces in character type data items.  
Half byte spaces for X type items and full byte spaces for N type items are embedded if Blank Space is 
selected.    It is selected by default



Default Edit Mode Setup
Select the edit mode for existing files, displayed in the Select Data File dialog box.    Edit mode can be 
selected from:

Add Only adds records to the file.    You cannot update existing records.

Update Gives access to all file and record update functions.

View Data can only be viewed.    No updates can be made.

The default is Update



Warning Message on Add/Copy for Indexed/Relative Files
In Record Format view you can enable or disable the display of a message on errors.    For indexed and 
relative files if an error occurs during an Add or Copy operation a message will or will not be displayed 
depending on the setting.    By default the message display is disabled.



Backup file
If the check box is checked a backup of the data file is created in the work file folder.    Backup files have 
the extension BAK

Example : 

            Data file name Backup file name

            FILE01.DAT FILE01.DAT.BAK



Tab Code
Select whether tab codes are expanded to 4 byte or 8 byte boundaries.    Default is to expand to 8 byte 
boundaries.



Character Code
The value for the COBOL library character code is ASCII, and no options are applicable. 



Case Sensitivity
Specify whether the source code should be treaded in a case sensitive manner or not.    By default case 
sensitivity is disabled.



Reference Format Type
Source Program
This setting is not used.    The default is Variable format.

Library
Select whether the Libraries are in Fixed length, Variable length, or Free format.    Default value is Variable 
Format.



Source Program
This setting is not used.    The default is Variable format.



Library
Select whether the Libraries are in Fixed length, Variable length, or Free format.    Default value is Variable 
Format.



Code Type of Data 
Select whether the data is held in ASCII, or EBCDIC.    The default is ASCII.



Code System
Select whether the data is held in ASCII, or EBCDIC.    The default is ASCII.



Table Format: Limit Item Display Width 
Specify the maximum item display width for cells in Table Format view.    When 0 is specified, Data Editor 
uses the width determined by the item's data description.    The default value is 0.



Edit Procedure
Specify whether zeroes are to be suppressed when numeric items are displayed.    Zeroes are displayed 
by default



Title bar

Data Editor displays the name of the file being edited followed by "Data Editor" in the title bar.

You can move the Data Editor Window by dragging the title bar.

The title bar elements are

 Control menu of the application
 Maximize button
 Minimize button
 Application name
 File name
 Restore Original Size button



Scroll bar
When the data is too long or to wide to fit into the window Data Editor displays scroll bars at the right and 
bottom sides of the window.    The scroll box inside the scroll bar indicates the data being displayed.    

Drag the scroll box to change the view of the data.

Click in the scroll bar to move a page up/down/left or right.

Click the arrows at the ends of the scroll bar to move up/down/left or right in smaller increments.



Resize command (System menu)

Use this command to switch into resize mode.    The mouse pointer changes to a 4-way arrow .    The 
window can be moved or resized using the mouse or the arrow keys.



Move command (control menu)

Use this command to switch into move mode. The mouse pointer changes to a 4-way arrow .    The 
window can be moved using the mouse or the arrow keys.



Minimize command (control menu)
Collapses the window to an icon.

Shortcut
Mouse: Click the minimize button on the title bar.



Maximize command (System menu)
Expands the window to fill the screen.

Shortcut
Mouse: Click the maximize button on the title bar or double click the title bar.



Close command (Control menu)
Closes the window and Data Editor.

Shortcuts
Mouse: Double click the control menu box

Keyboard: ALT+F4 (For closing main window or dialog box)



Restore command (Control menu)
Returns a Maximized or Minimized window to its previous size and position.



[Change of application...] command (control menu)
Displays a list of running applications.    From this task list, you can switch to or close any application.

Shortcut
Keyboard: CTRL+ESC



Context Help command 

Use the Context Help command to obtain help on some portion of Data Editor.    When you choose the 
Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.    Then click 
somewhere in the Data Editor window, such as another Toolbar button.    The Help topic will be shown for 
the item you clicked.

Shortcut
Keys: SHIFT+F1



Explanation regarding Select Test Case control



Data File Name
Displays file name and folder name of the data file specified in the Open file dialog box.



Folder
Displays the folder name of the data file specified in the Open file dialog box.



File name
Displays the file name of the data file specified in the Open file dialog box.



Data File Edit Mode 
When creating a new data file, the edit mode is automatically set to Add. 

When working on an existing data file, the edit mode can be selected from:

Add       Only adds records to the file.    You cannot update existing records.

Update       Gives access to all file and record update functions.

View       Data can only be viewed.    No updates can be made.



Update
In Update mode you can perform all the updating functions such as editing items, deleting and adding 
records.



Add
In Add mode you can only add new records to the data file.    You do not get access to existing records, 
therefore the Range option is disabled when Add is selected.

Add mode is the default for new files.



View
In View mode you can browse the records with all the editing and updating functions disabled.



Data File
Displays information about the data file.    Library information is specified in the Data File Setup dialog 
box.



Data File Setup
Displays Data File Setup dialog box .    Click the button when you need to update the data file information.



Library
Displays information about the library and extracted from the library in the Data File Setup process.



File name (Library)
Displays library file name set in the Data File Setup dialog box.



Record length (Library)
Displays the record length determined by analyzing the library file.



Character Code
Displays code set of the COBOL library file.



Data File Information
Displays data file information set in the Data File Setup dialog box.



File Organization
Displays the file organization set in Data File Setup dialog box.



Record Format
Displays the record format set in Data File Setup dialog box.



Record Length (Data file)
Displays the record length set in Data File Setup dialog box.



Key Information (Button)
For indexed files, you can view and edit the key definitions.



Code Information (Data file)
Displays character code information set in the Data File Setup dialog box.



Select Range of Records
Gives the option only to load a specified range of records.    This option if disabled when the edit mode is 
set to Add.



Range
Select from "Selection" or "All".    When you choose "Selection" you must specify the range by clicking on 
the Select Range button.    The default value is All. This option if disabled when the edit mode is set to 
Add.



Select Range
Displays a dialog box in which you specify the range of records to be loaded.    Only enabled when the 
Range is set to "Selection".



Comment
Displays the comment entered in the Data File Setup dialog box.



Explanation regarding Data File Setup dialog box.



Data File
Sets up and displays all the data file information required by Data Editor.



Library
Displays information extracted from the COBOL library and provides for the setup of the library file name.



File Name
Displays the COBOL library file name.



Record Length
Displays the record length determined by analyzing the library file.

When a library file holds multiple records, all record lengths must be the same.



Analyze Library
Click to specify and analyze the library file.



Character Code
Displays code set of the COBOL library file.



Data File Information
Lets you setup the data file information:    file organization, record format, record length, key information, 
and code information.



File Organization
Select the file organization for the data file from sequential, line sequential, indexed or relative.



Record Format
Select whether the data file is fixed length or variable length format.

Note:    You cannot set the format for existing indexed files.    The format is obtained automatically.



Record Length
Enter the maximum record length.

Note:    You cannot set the record length for existing indexed files.    The length is obtained automatically.



Key Information
Specify key information when creating a new indexed file.    Click on Setup to bring up the Key Information
Setup dialog box.

Note:    You cannot set key information for existing indexed files.    The key information is obtained 
automatically from the indexed file header.



Code Information
Specify the character code for the data file.



Character Code
Select whether the data file is in ASCII or EBCDIC character set.    The default is ASCII.



Comment
Enter an (optional) comment to describe the data file.



Explanation regarding key information setup control.



Primary Key
Enter a string to define the structure of the primary key.    The format is:
offset, length [/offset-2, length-2]...
The first byte in the record is offset 1.

If the key is in multiple parts (a "split key") separate the parts using a "/".

Example: 1,10/16,5        (the key is in two parts, the first is 10 bytes long starting at the first byte, the 
second part is 5 bytes long starting at the 16th byte)

The total length of the key definition string must be less than 256 characters.



Secondary Key
Enter a string to define the structure of the secondary key.    The format is:
offset, length [/offset-2, length-2]...
The first byte in the record is offset 1.

If the key is in multiple parts (a "split key") separate the parts using a "/".

Example: 1,10/16,5        (the key is in two parts, the first is 10 bytes long starting at the first byte, the 
second part is 5 bytes long starting at the 16th byte)

The total length of the key definition string must be less than 256 characters.



Duplicate Key
Check this box when duplicate keys are allowed.



Explanation regarding save sequence range specification control.



First Record
Specify the number of the first record to be loaded.

Default is 1.



Last Record
Specify the number of the last record to be loaded.    If zero is entered the last record loaded will be the 
last record in the file.

Default is zero.



Explanation regarding Record Format Screen Control.



Status
Displays the status of the current record.    Possible status values are:

                          Blank indicates that no modifications have been made to the record.

Update Changes have been made to the record.

Add              This is a new record.

Delete    The record is marked for deletion.



Record Length
Displays the length of the current record.

You can use this field to change the length of newly added records in variable length files.



Record Number
Displays the number of the current record and the total number of records loaded.



Explanation regarding Table Format Screen control.



Item Name
Displays the name of the item that has focus and whose contents are displayed in the field at the top of 
the table.



Data Edit Area
Displays the contents of the item that has focus.    The contents can only be edited in this field.



Explanation regarding Update Confirmation Control.



Number of Records Updated
Displays the number of records updated in this edit session.



Number of Records Added
Displays the number of records added in this edit session.



Number of Records Deleted
Displays the number of records deleted in this edit session.



Save Select Items
Check this box to have Data Editor save the list of items you selected to be displayed.



Explanation regarding Record Copy Control.



Copy Record Number
Enter the record number before which the copies should be inserted.    Specify zero to append the copies 
to the end of the file.    The default is the position of the current record.



Number of Copies
Specify the number of copies.



Explanation regarding Item-Select Control.



Record Format
Lists all 01 level records defined in the library file.    Select the format you desire from this list.    Default is 
the first record defined in the library file.



Show OCCURS Items
Check the box to have all iterations of an OCCURS table displayed.    If not checked only the first 
occurrence in the table is displayed.    Default is not to show all the iterations.

This is enabled only if OCCURS items exist in the library.



Select Items to be Displayed List Box
List box displays the level numbers, names and data descriptions for all items in the record selected from 
the Record Format list.

If no items are selected all the items will be displayed in the table format and record format views.    
Otherwise only selected items are displayed.

"R" in the first column indicates the start of a REDEFINES group.

Items that correspond to the primary key are always displayed (though they will not be shown as selected 
on the first invocation of this dialog)

Checks:
After you make your selection Data Editor checks for:

- Selection of elementary items within a selected group.    In this case only the group level item is 
displayed.

- Selection of REDEFINES and redefined items.    Only the redefined item is displayed.



Reset
Click reset to revert to displaying all the items.



Level
Displays the level number of the data items as defined in the library.    Indents the first 5 levels.    All levels 
above the fifth level are displayed at the same indent. 



Description
Displays a simplified version of the data description extracted from the library file.



Item Name
Displays the item name defined in the library.



Explanation regarding hexadecimal edit control.



Hexadecimal Edit
Displays the data in hexadecimal format.    You can edit the number displayed.    Confirm your change by 
using the Enter key or the close button.    Cancel your changes by using the Esc key.



Explanation regarding record number specification control.



Record Number
Specify the number of the record to be displayed.    Specify zero to display the last record.



Explanation regarding Record Operation Control.



Process Record
For Insert and Append: specify the number of records to be inserted or appended.

For Delete: specify the number of records to be deleted from the current record.



Explanation regarding MDPORT link control.



Output Data Format
Select output file format from Data File Format (i.e. a COBOL file organization) and CSV Format (comma 
separated values).



Output Items in Select Items Only
If checked only items that are currently displayed are output.    All iterations of OCCURS items are passed
whether or not they are displayed.

The default is the setting when Data Converter was last invoked.



Start Data Converter
The specified data is passed to Data Converter.
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